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Important Notice 
Because of the nature of wireless communications, transmission and 
reception of data can never be guaranteed.  Data may be delayed, 
corrupted (i.e., have errors) or be totally lost.  Although significant delays 
or losses of data are rare when wireless devices such as the Sierra 
Wireless modem are used in a normal manner with a well-constructed 
network, the Sierra Wireless modem should not be used in situations 
where failure to transmit or receive data could result in damage of any 
kind to the user or any other party, including but not limited to personal 
injury, death, or loss of property.  Sierra Wireless accepts no 
responsibility for damages of any kind resulting from delays or errors in 
data transmitted or received using the Sierra Wireless modem, or for 
failure of the Sierra Wireless modem to transmit or receive such data. 

Safety and Hazards 
Do not operate the Sierra Wireless modem in areas where blasting is in 
progress, where explosive atmospheres may be present, near medical 
equipment, near life support equipment, or any equipment which may be 
susceptible to any form of radio interference.  In such areas, the Sierra 
Wireless modem MUST BE POWERED OFF.  The Sierra Wireless 
modem can transmit signals that could interfere with this equipment. 

Do not operate the Sierra Wireless modem in any aircraft, whether the 
aircraft is on the ground or in flight.  In aircraft, the Sierra Wireless 
modem MUST BE POWERED OFF.  When operating, the Sierra 
Wireless modem can transmit signals that could interfere with various 
onboard systems. 

The driver or operator of any vehicle should not operate the Sierra 
Wireless modem while in control of a vehicle.  Doing so will detract from 
the driver or operator's control and operation of that vehicle.  In some 
states and provinces, operating such communications devices while in 
control of a vehicle is an offence. 

Note:  Some airlines may permit the use of cellular phones while the aircraft is on the 
ground and the door is open.  Sierra Wireless modems may be used at this time. 

Limitation of Liability 
The information in this manual is subject to change without notice and 
does not represent a commitment on the part of Sierra Wireless or its 
affiliates.  SIERRA WIRELESS AND ITS AFFILIATES SPECIFICALLY 
DISCLAIM LIABILITY FOR ANY AND ALL DIRECT, INDIRECT, 
SPECIAL, GENERAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR 
EXEMPLARY DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS 
OF PROFITS OR REVENUE OR ANTICIPATED PROFITS OR 
REVENUE ARISING OUT OF THE USE OR INABILITY TO USE ANY 
SIERRA WIRELESS PRODUCT, EVEN IF SIERRA WIRELESS AND/OR 
ITS AFFILIATES HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES OR THEY ARE FORESEEABLE OR FOR CLAIMS BY ANY 
THIRD PARTY. 
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Notwithstanding the foregoing, in no event shall Sierra Wireless and/or its 
affiliates aggregate liability arising under or in connection with the Sierra 
Wireless product, regardless of the number of events, occurrences, or 
claims giving rise to liability, be in excess of the price paid by the 
purchaser for the Sierra Wireless product. 

Patents 
This product may contain technology developed by or for Sierra Wireless 
Inc. This product includes technology licensed from QUALCOMM®. This 
product is manufactured or sold by Sierra Wireless Inc. or its affiliates 
under one or more patents licensed from InterDigital Group. 

Trademarks 
AirCard® is a registered trademark of Sierra Wireless. Sierra Wireless™, 
AirPrime™, AirLink™, AirVantage™, Watcher™ and the Sierra Wireless 
logo are trademarks of Sierra Wireless. 

Windows® and Windows Vista® are registered trademarks of Microsoft 
Corporation. 

Macintosh and Mac OS are registered trademarks of Apple Inc., 
registered in the U.S. and other countries. 

QUALCOMM® is a registered trademark of QUALCOMM Incorporated. 
Used under license. 

Other trademarks are the property of the respective owners. 

Contact information 
Sales Desk Phone: 1-604-232-1488 

 Hours: 8:00 am to 5:00 pm Pacific Time 

 e-mail: sales@sierrawireless.com 

Technical Support: Included with the purchase of the SW Device Development 
Kit you receive five hours of tier 3 engineering integration 
support.  You will have received instructions by e-mail on 
how to access the OEM Customer Support web site.  For 
more details, please contact your account manager, or the 
Sierra Wireless sales desk 

RMA Support: repairs@sierrawireless.com  

Post: Sierra Wireless 
13811 Wireless Way 
Richmond, BC 
Canada   V6V 3A4 

Fax: 1-604-231-1109 

Web: www.sierrawireless.com 
Consult our website for up-to-date product descriptions, documentation, 
application notes, firmware upgrades, troubleshooting tips, and press 
releases: www.sierrawireless.com 

mailto:repairs@sierrawireless.com
http://www.sierrawireless.com/
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Introduction 
This document describes how to install and use the Product Support Tool 
from Sierra Wireless.  

The Product Support Tool allows the user to: 

• Upgrade software in a Sierra Wireless modem 

• Provision the modem (by loading a PRL and configuring certain 
settings) 

• Copy a user’s account and personal settings from one device to 
another. 

• Save/load settings 

Revision history 
Version Summary of changes 

1.0  Apr 04 Initial release 

1.1  May 09 The Product Support Tool no longer supports downloading 
software to the modem (page 11). 

Added: 

• This table 
• “Troubleshooting logs” (page 17) 
• References to ExpressCard and USB modems, Windows Vista 
• References to pESN and MEID 

2  Aug 12 New template. 
Changes to the patents section. 

System requirements 
To use the software, you need: 

• PC running Windows Vista, Windows XP, or Windows 2000 

• License key for the Product Support Tool. (If you don’t have a license 
key, please contact your account manager, or the Sierra Wireless 
sales desk). 

If the modem is a PC Card, your computer must have a PC Card slot or 
an adapter board that allows you to connect a PC Card. 
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If the modem is an ExpressCard, your computer must have an 
ExpressCard slot or an adapter board that allows you to connect an 
ExpressCard. 

If the modem is a USB modem, your computer must have a USB slot. 

If the modem is an embedded module or Mini Card, you also need the 
appropriate development kit board. 

Installing the Product Support Tool 
1. If you already have the Product Support Tool installed (versions 

before 1.07), uninstall it. (To view the version, click Help > About 
SWPST). 

2. If the modem is a PC Card, ExpressCard, or USB modem, install the 
software for the modem. For instructions, see the documentation of 
the modem. After the installation is complete, if the software for the 
modem is running, close it (it must not be running when you run the 
Product Support Tool). 

3. If the modem is an embedded module or Mini Card, ensure the 
modem is inserted into the development kit board, and the board is 
connected to the PC. 

4. Run the file SWPST Installer.exe. 

5. Enter the license key. Click Next. 

6. Follow the on-screen instructions. 

Starting the Product Support Tool 
To start the software: 

1. On the desktop, double click the Sierra Wireless PST icon 

. 

The Software window of the Product Support Tool is displayed. 
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Connected and offline mode 
The Product Support Tool can be in connected or in offline mode. When 
the Product Support Tool starts, it is in offline mode. 

In offline mode, the Product Support Tool cannot communicate with the 
modem. You cannot modify any settings on the modem. 

In connected mode, the Product Support Tool communicates with the 
modem. You can modify settings on the modem. 

Table 1 shows the features available in each of the modes. Table 2 
describes the Connect button in each of the modes. (The Connect button 
is located in the upper left corner of the Product Support Tool window—
under the menu items.) 

Table 1 Offline vs. connected mode 

 Offline mode Connected mode 

Can the Product Support Tool 
communicate with the modem? 

No Yes 

Load/save settings (from a file, to a 
file) 

Yes Yes 

Load/save settings (from a file to a 
modem, or from a modem to a file) 

No Yes 

Upgrade software No Yes 

Provision the modem No Yes 

Copy a user’s account and personal 
settings from one device to another 

No Yes 
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Table 2 Connect button 

 Offline mode Connected mode 

Connect button 
 (cables appear 

together) 
 (cables appear 

apart) 

Clicking the Connect button Puts the Product 
Support Tool into 
connected mode 

Puts the Product 
Support Tool into offline 
mode 

For more information on offline mode, see “Work Offline” (below). 

To modify any settings on the modem, you must put the software into 
connected mode (page 10). 

Work Offline 

You can use offline mode, for example, when: 

• You don’t have a modem, but you want to see which parameters are 
configurable for a particular model of modem. 

• You don’t have a modem. You can load modem settings from a file (or 
create settings from scratch), modify them and save to the same or a 
new file. When the modem becomes available, put the software into 
connected mode and then load the new settings from the file onto the 
modem. 

• You have a modem, and you want to create various modem settings 
files, for later testing (you currently don’t want to modify the settings 
on the modem). 

To select a modem to work with while in offline mode: 

1.  Click the Connect button  (in the toolbar, under the menu bar of 
the Product Support Tool window). 

The software searches for the COMM ports for the modem. This may 
take a few seconds. 
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When the COMM ports have been found, a list of devices is 
displayed: 

 
2.  Click Work Offline. 

The Work Offline window is displayed. Select the product you want to 
work with. 

 
The status bar shows the model of the selected device (for example, 
“SW Device” in the following screenshot), and “Offline”. 

 

Determining the connection mode of the 
software 

When you start the software, the software is in offline mode, that is, the 
Product Support Tool cannot communicate with the modem. The right 
portion of the status bar displays “Offline”, as shown in the following table. 

Once you put the software into connected mode (page 10), the status bar 
shows the model of the modem, the ESN (or pESN and MEID), and 
software version of the modem. 
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Table 3 Determining the connection mode of the Product Support Tool 

Connection 
mode 

Lower right corner of the Product Support 
Tool window 

Connect button 

Offline  
or, when you choose Work Offline and select a 
modem model,  (cables appear 

together)   
 

 Model of modem 

Connected  

 (cables appear apart) 
 Model 

of 
modem 

ESN (or pESN and MEID) of 
the modem 

Software 
version 
of the 
modem 

Putting the software into connected 
mode 

Before you configure a modem, you must put the Product Support Tool 
into connected mode: 

1.  Click the Connect button  (in the toolbar, under the menu bar of 
the Product Support Tool window). 

The software searches for the COMM ports for the modem. This may 
take a few seconds. 

When the COMM ports have been found, a list of devices is 
displayed: 

 
2.  Select the desired modem and click Connect. 

When the Product Support Tool has established a connection to the 
modem, the status bar shows the model of the modem (for example, 
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MC5725 in the following screenshot), the ESN (or pESN and MEID), and 
software version of the modem. 

 
You can now download software (see the next section), and then use the 
Product Support Tool to provision the modem (page 11) and copy 
settings (page 14). 

Downloading software to the modem 
To download the modem software, use the FlashCDMA or SWFlash 
software from Sierra Wireless, and then proceed to “Provisioning the 
modem” (the next section). 

Provisioning the modem 
Through provisioning, you can program the modem’s PRL and, for certain 
models of modems, other parameters. 

By working offline, you can see which parameters are configurable for a 
particular model of modem, even if you don’t have such a modem on 
hand. 

Provisioning is done through the Provision window. 

Displaying the Provision window 
To display the Provision window: 

1. Unless you want to work offline, ensure the Product Support Tool is in 
connected mode (page 7). 

2. In the left pane of the Product Support Tool window, click Provision. 
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The Provision window is displayed. The number and type of tabs depends 
on the model of the modem. 

 

Retrieving information from the modem 
1.  Ensure the Product Support Tool is in connected mode (page 7). 

2.  In the Provision window, click Read Device. 

The provisioning information is read from the modem and displayed in the 
Provision window. You can now use the tab(s) to view or change the 
information. 

Specifying the data and file(s) to write to the modem 
Warning:  Edit the modem’s parameters only if you know what you are doing. You 
can inadvertently make the modem unusable. 
The Refurbish button erases data for MIN and user profiles. The modem becomes non-
activated. 

To specify the data and file(s) to be written to the modem: 

1.  Display the appropriate tab (in some cases, only one tab is displayed; 
this depends on the model of the modem). For example, to specify a 
PRL file, click the PRL tab. 

2.  Click Browse. Select the file. 

3.  Click Open. 

The filename you selected is displayed in the Filename field (under 
File Information). 
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4.  If required, modify the parameters. 

Depending on the tab you’ve selected, you may be able to change 
only certain parameters. For some tabs, you may not be able to 
change any parameters. 

5.  Repeat the above steps (with the other tabs available) for all the data 
and file(s) you want to write to the modem. 

Writing the settings to the modem 
To write the settings to the modem: 

1. Specify the file(s) to write to the modem (see the previous section). 

2. Click Write Device (in the bottom part of the Provision window). 

The Write Mobile window is displayed, from which you can select 
which settings to write to the modem. 

 
3. Select the items you want to write to the modem and click OK. 

Saving NV items to a file 
Optionally, you can save NV items1 to a file: 

1. Retrieve the information from the modem (page 12). 

2. Select File > Save As. The default file extension type is .nvm. 

Loading NV items from a file 
Optionally, you can load NV items from a file to which you have 
previously saved NV items: 

1.  Select File > Open. 

The default file extension type is .nvm. 

                                            
1 Items in the modem’s non-volatile memory 
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Copying settings 
You can copy settings: 

• From one modem to another (page 15) 

• From a modem to a file (page 16) 

• From a file to a modem (page 17) 

To display the Copy window, from which you can copy settings: 

1.  Ensure the Product Support Tool is in connected mode (page 7). 

2.  In the left pane of the Product Support Tool window, click Copy. 
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The Copy window is displayed. 

 

Copy settings from one modem to another 
When copying settings from one modem to another, they must both be of 
the same model. 

To copy settings from one modem to another: 

1.  In the Copy window, under Copy Between Devices, click Copy. 

The software reads the settings from the currently connected modem 
(that is, the source modem), then displays a window (Swap Devices) 
instructing you to connect the destination device. 

2.  If the source modem is a PC Card, ExpressCard, or USB modem, 
before you remove it, stop the modem (use the icon in the Windows 
status area [typically, in the lower right corner of the screen]). 

3.  Remove the source device. 

4.  Insert the destination modem. 

5.  Click Next. 
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The Dialog window is displayed. 

 
6.  Click Next. 

The software searches for modems and displays a window that lists 
devices. 

 
7.  Select your device and click Connect. 

The software writes to the destination modem the settings it read from the 
source device, then resets the modem. 

Copy modem settings to a file 
To copy a modem’s settings to a file: 

1.  In the Copy window, under Copy To File, click Copy. 

A window is displayed, from which you can specify a filename (*.cpy) 
and optionally change the path of the file to which the modem settings 
will be saved. 

2.  Specify the filename and click Save. 
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Copy settings from a file 
The file must have been saved from a modem that’s the same model as 
the destination modem. 

To load settings from a file into a modem: 

1.  In the Copy window, under Copy From File, click Copy. 

A window is displayed, from which you can browse to the file you want 
to load (*.cpy). 

2.  Browse to the file, and click Open. 

The software reads the settings from the file, writes the settings to the 
modem, then resets the modem. 

Troubleshooting logs 
The following table describes the various logs that the Product Support 
Tool maintains; the logs that can be helpful for troubleshooting. 

Table 4 Troubleshooting logs 

Description of log Path Filename 

Connection C:\Program Files\Sierra 
Wireless\Sierra Wireless 
PST\Log\ 

SWPST_CONNECT.Log 

OMADM Read C:\Temp\Log\ LogFile_OMADM_READ.Log 

OMADM Write C:\Temp\Log\ LogFile_OMADM_WRITE.Log 
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